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End User Licence Agreement 

This software is for use with the 
“EnSURE”, "SystemSURE Plus", and "SystemSURE II" Luminometers. 

By installing, copying, or using this software, you acknowledge that 
you have read, understand, and agree to be bound by the terms and 

conditions of this licence agreement. 

You may freely install and use this software on one or more 
compatible computer(s) within your organisation. 

This software may be installed on a shared or networked file system 
or server. However, due to possible operating system 

incompatibilities, it cannot be guaranteed that such multi-user 
access will not result in a loss of stored data. 

You may make one backup copy of the software installation disk, 
provided this backup copy is not installed or used on any computer, 
except where the original installation disk is damaged or has been 

destroyed. 

This software is provided "as is" without warranties of any kind 
either expressed or implied including warranties of merchantability 

or fitness for a particular purpose. 

Hygiena LLC shall not be liable for any loss of profit, loss of use, loss 
of software, loss of data, interruption to business, nor for indirect, 
special, incidental or consequential damages of any kind whether 

under this agreement or not. 

This software and any associated documentation remains the 
property of Hygiena LLC at all times and may not be copied, in part 

or in full, for the purposes of redistribution or resale without the 
prior written permission of Hygiena LLC. 
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1 Introduction 

The SureTrend Data Analysis Software is a standalone test results database and trend 
analysis application, for use with the EnSURE and SystemSURE Plus luminometers.   

For the purposes of this document the term “Unit” and “Luminometer” are 
interchangeable, and refer to EnSURE, SystemSURE Plus, and SystemSURE II 
luminometers. For information refer to the Luminometer Operator’s Manual that came 
with the luminometer. 

The core elements of the SureTrend software are: 

 

The key advantages and features of the SureTrend software are: 

 Fully standalone application with no need for third-party software such as 
Microsoft Excel or Microsoft Access. 

 Direct uploading of test results data from one or more luminometers. 

 Storage of uploaded results in to a single contiguous database file, which can be 
protected to prevent accidental or fraudulent manipulation of the data. 

 Optional annotation of test results and report output data. 

 Standard set of built-in reports with data and graphs that can be printed. 

 The ability to create new reports and configure, or reconfigure any report, 
including filtering, sort order, and grouping. 

 Trend analysis of test results data over specific time periods. 

 Program location and threshold set-up and download to individual units. 

 Support for User ID, program location names, and sample test plan definition 
that can be downloaded to the Luminometer. 

 Automatic PC clock date, time and format synchronisation with the luminometer. 

Please refer to the appropriate Operator's Manual for details of the Luminometer. 

For any other technical assistance, please contact your local distributor. 
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1.1 Installing the SureTrend Software 

IMPORTANT: Please make sure you have read and understand the “Conditions and 
Limitations of Use” section at the beginning of this manual before continuing any 
further. 

Do not install this software if you are not in agreement with the “Conditions and 
Limitations of Use”. 

It is strongly recommended that you read this entire manual before installing and 
running the SureTrend software, as some features may need to be configured prior to 
uploading any test results from the Luminometer. 

The software is installed onto your computer by inserting the CD into your CD-ROM 
drive and following the installation script screen prompts. If the install script does not 
automatically start, open Windows Explorer and select the CD-ROM that contains the 
SureTrend CD-ROM. Open the CD-ROM and open the Setup.hta file. 

TIP: You need to have appropriate permissions in order to install the software. This is 
typically the computer administrator. 

NOTE: If the SureTrend data files are to be accessed by multiple users, the software 
and data files should be installed onto the shared file server first, and then additionally 
installed on each local user’s PC. When the installation is complete, each user 
installation of the software should be individually configured to the needs and privileges 
of each user and their computer hardware capabilities. Please refer to section 9 for 
software set-up details. 

Once installed, the new software is run by selecting the 

SureTrend - Data Analysis Software shortcut from the 
Windows start menu: 

Digital versions of the SureTrend User's Guide and the 
Luminometer Operator’s Manual are installed with the 
SureTrend software. The SureTrend User’s Guide and the 
Luminometer Operator’s Manual are accessible from the 
SureTrend software Windows program group. The SureTrend 

User’s Guide is also accessible from the Help menu of the 
SureTrend software.  The manuals are stored in Adobe PDF 
and Microsoft XPS formats for your convenience. 

 

Adobe, Adobe Reader and the Adobe PDF logo are 
registered trademarks of Adobe Systems Incorporated. 
All Adobe software is subject to its own Terms and 
Conditions of Use, and is not covered by any licence or 
warrantee agreement with Hygiena LLC. 

 

XPS, and the XPS logo are registered trademarks of 
Microsoft. All Microsoft software is subject to its own 
Terms and Conditions of Use, and is not covered by any 
licence or warrantee agreement with Hygiena LLC. 
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1.2 Upgrading the SureTrend Software 

If you have an earlier version of SureTrend installed on your computer the SureTrend 
install will attempt to upgrade your current install or create a new installation depending 
on the age of the previous version. Versions prior to 2009, and older DataSure 
installations are not upgraded. SureTrend version after 2009 will be upgraded. 

If you do not want to upgrade your current installation you can install SureTrend on 
another computer. 

1.3 Uninstalling the SureTrend Software 

To uninstall the SureTrend software from your PC, use the Add or Remove Programs 

option in the Windows Control Panel. Then select Hygiena SureTrend from the list of 
currently installed programs and follow the on-screen prompts. 

NOTE: Please make a backup copy off SureTrend and all data files before uninstalling 
the software. 

2 General Software Features 

When the SureTrend software is opened (from the Windows start menu), the following 
application screen is displayed: 

Menu Bar

Toolbar

Navigator

Data Window

Status Bar
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2.1 Toolbar Buttons and Menu Bar Options  

The toolbar has the following buttons: 

 

These toolbar buttons provide shortcuts to commonly used menu bar options:  

File Menu Toolbar Action Performed Section 

Open  Open the selected data file 2.7 

Close  Close the current data file 2.2 

Close All  Close all open data files 2.2 

Save  Save data file changes to disk 2.5 

Revert  Discard any changes are reopen the previously 
saved data file 

 

Synchronise...  Transfer data between SureTrend software and the 
unit 

2.9 

Import...  Import database, reports and unit set-up data files 
from other sites 

2.8 

Export...  Export database, reports and unit set-up data files to 
other sites 

2.8.1 

Create Archive 
File 

 Reduce the size of the Results Database by 
archiving old data 

5 

Printer Set-up...  Set-up the printer properties  

Print Preview  Preview the output prior to printing  

Print...  Print table data or report chart  

Exit  Close the SureTrend software  

 

Edit Menu Toolbar Action Performed Section 

Cut  Copy and delete selected data 2.5 

Copy  Copy selected data 2.5 

Paste  Paste selected data 2.5 

Delete  Delete selected data or set-up 
file 

2.5 

Select All  Select all data for copy/cut/paste 2.5 

Select None  Cancel the data selection 2.5 

Search...  Search for data 2.4 

Edit ‘Notes’ Field  Edit the data table 'Notes' field 2.5 
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Reports Menu Toolbar Action Performed Section 

Create New Report  Create a new report set-up file 5.8 

Set-up Report  Modify the existing report set-up file 5.8 

Generate Report  Run the selected report 5.4 

Statistics  Preview statistical data 4.5 

Standard Report #1  Run 'Standard Report #1' 5.4 

Standard Report #2  Run 'Standard Report #2' 5.4 

Standard Report #3  Run 'Standard Report #3' 5.4 

Failures Report  Run 'Standard Failures Report' 5.4 

 

Set-up Menu Toolbar Action Performed Section 

Add New Unit  Add a new unit to the SureTrend software 0 

Add Test Plan  Add a new Test Plan to the unit set-up data 7.5 

Delete Test 
Plan 

 Remove a new Test Plan from the unit set-
up data 

7.5 

Set Unit Clock  Send the PC's clock time and date to the 
unit 

9.3 

Password  Set or change the data protection password 9.1 

Preferences...  Access the SureTrend software 
configuration options 

9 

 

Help Menu Toolbar Action Performed Section 

User’s Manual  Open this help file 8 

Technical Support  Open the Hygiena Technical Support 
internet page 

8 

About SureTrend  Display the SureTrend software version 
details 

 

 

TIP: For consistency, this manual makes specific reference to the menu 

options (e.g. "the Search option from the Edit menu"), however if there is 
an associated toolbar button (e.g. " ") this can be clicked instead. 

Also, some options are also available on the right-click context menus, for 
example. 
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2.2 Navigator and Data Windows 

The Navigator is located on the left-hand-side of the SureTrend 
application screen, and maintains a list of all data windows and 
open data files: 

When new data files are opened, they are added to the Navigator 

list. Data files and windows can be closed by selecting the Close 

or Close All option from the File menu. 

When a Navigator list item is selected (by clicking to the item 
name), the associated data is displayed in the Data Window area of the application. 

The data is generally displayed in the form of a table of data records (running down the 
window in rows), with each record consisting of a set of related data fields (arranged 
across the window in columns): 

  Record Data Fields  


 D

a
ta

 R
e

c
o

rd
s
 

 

 

The contents of the data window and the data record fields are specific to each data 
table type. Refer to sections 4 to 7 for further details. 

2.3 Data Table Sorting 

When the data table file is first opened, it is automatically sorted into ascending order, 
according to the values of the data field in the left-most column. 

The table can be sorted by any of the data fields, either in ascending order or 
descending order, by clicking on the appropriate data window column headings: 

 

For example, clicking on the Date Modified column heading of the Reports window will 
sort the table into ascending order with the oldest report file at the top of the table. 
Whereas, clicking the column heading again will sort the list into descending order with 
the most recently modified file at the top. 
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2.4 Selecting Data Records 

To select a single data record, simply click on the table row: 

 

You can then perform various data functions (such as Copy) by either: selecting the 
menu option from the menu bar; clicking on the toolbar button; or right-clicking on the 
selected data to access the context menu. 

To select more than one table record, hold down the Ctrl key on the keyboard and then 
click on each of the rows you wish to select. 

To select a range of records, click on the first table row, then hold down the keyboard 

Shift key and click on the last row you wish to select. This will select the first row 
clicked, the last row, and all the rows in between. 

You can also use the Search option from the Edit menu to search for and select all 
records that contains the specified text: 

 

NOTE: The Search option performs a text search on all records and fields and is case 
insensitive (i.e. upper and lower case letters are treated as being the same). 

TIP: If the Select all matching records option is not checked, the Search option will 
find the next matching record after the currently selected record. This can be repeated 
to step through each occurrence of the text. 
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2.5 Data Table Editing 

Where allowed, the user can edit or modify the contents of the data table's record fields 
in several ways. 

Most editable data fields can be changed by double-clicking on the field data value, and 
typing-in the new value or selecting one from the drop-down list. 

  

Selecting several data rows and then using the right-click menu Edit options. This will 
start editing on the first available field on the first selected row. There is no need to 
double click on each field. The values can be entered and the Enter key will proceed to 
the next editable field. 

 

When selecting multiple table rows and editing the ‘Notes’ or ‘User Id’; field, you will be 
prompted as to whether you wish to apply the same entered text to all of the selected 

records. If you answer No, the software will step through each selected row to enter the 
appropriate data. 

Selecting one or more data rows and copying (Copy) and pasting (Paste) the selected 
data into a different part of the table. 

NOTE: If the data field you are attempting to change is 'edit protected' (see section 9.1) 
you will be prompted for a password before the value can be modified. 

Refer to sections 4 to 7 for details of which record data fields can be modified and what 
right-click context menu options are available. 

TIP: Whenever the data table contents is changed, the window text will turn BLUE to 
indicate that the data file has been modified and needs to be saved by selecting the 

Save option from the File menu. 
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2.6 Exporting Table Data  

To export the entire contents of a data table to Microsoft Excel, perform the following: 

a) Open the data table from the Navigator list. 

b) Select the Export option from the Files menu. 

c) Choose a destination filename and folder location. 

d) Click the Save button. 

e) The data table will then be converted and saved as an Excel file. This can take a 
while for large tables. 

NOTE: Due to the limitations of the Microsoft Excel 2003 and earlier, only the first 
65535 data records can be exported. Larger tables will be truncated. 

Alternatively, to export a smaller section of data from the data table into another 
application, such as Microsoft Word or Microsoft Excel, perform the following: 

a) Select the data rows from the table you wish to export. 

b) Select the Copy option from the Edit menu to transfer the data (including column 
heading) into the Windows Clipboard. 

c) Go to your other application and Paste the copied data into the document at the 
appropriate position. 

d) Edit the pasted data into the desired format and style. 

Refer to section 2.8.1 for details of how to export and share data files between other 
SureTrend users. 

2.7 Shared Data File Access 

The SureTrend software is designed to run on a single Windows computer with one or 
more luminometers. You can have multiple computers running SureTrend access the 
Results Database, Report Data, User IDs and Unit Set-up Data files via a shared 
network file server or network shared disk. However, this can cause an access conflict if 
two or more users try to view or modify the same data file at the same time. This 
conflict is resolved as follows: 

1. The first user to open the data file is given full 'read-write' permission, allowing 
the data to be viewed and modified.  

2. Subsequent users who attempt to open the same data file are given restricted 
'read-only' permission, allowing the file contents to be viewed but not modified. In 

this case the data window text will turn GREY to indicate that the data cannot be 
edited. 

3. Once the first user has closed the data file, one of the other users can gain full 

'read-write' permission by reopening the data file using the Open option in the 

File menu. If successful, the window text will turn BLACK and the file contents 
can now be edited. 
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NOTE: If the user does not normally have the authority to modify the data file contents 
(in that, a password is required to alter the data), the file will be initially opened as 'read-
only'. When the user attempts to modify the data, they will be prompted for the 
password and then the file will be reopened with full 'read-write' permissions. 

TIP: The Monitor Shared Files set-up option (see section 9.6) can be used to 
automatically check the status of 'read-only' data files to determine whether the data 
has been modified by another user. 

2.8 Importing and Export Data Files 

As well as allowing multiple users to access a common set of SureTrend data files on a 
local network system, these files can also be exported from one site, emailed (for 
example) to another site, and imported back into the SureTrend software. 

2.8.1 Exporting Data Files 

To export an archived data file, a report set-up or output file, or a unit set-up data file, 
perform the following: 

a) Open the appropriate Archived Data, Reports or Unit Set-up Data window from 
the Navigator list. 

b) Select the file (or files) to be exported from the file table. 

c) Select the Export option from the File menu. 

d) Select a destination filename and folder. 

e) Click the Save button to export the data files as a single output file. 

TIP: This can also be used to back up your data files into a single output file, which can 
be reopened at a later date, if need be, and the stored files imported back into the 
software. 

To export the Results Database file, perform the following: 

a) Open the Archived Data window from the Navigator list. 

b) Select the Results Database file from the file table. 

c) Select the Export option from the File menu. 

d) Select a destination filename and folder. 

e) Click the Save button to save the database file as a new exported file. 

Refer to section 2.6 for details of how to convert and save the Results Database file as 
a Microsoft Excel file. 
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2.8.2 Importing Data Files 

To import data files from another site or remote user, perform the following: 

a) Select the Import option from the File menu. 

b) Browse to the folder where the new files are located. 

c) Select the files to be imported from the file list (using the Ctrl and Shift keys to 
select more than one file at a time if required). 

d) Click the Open button to read the selected data files into the SureTrend software 
and automatically stored them the appropriate data folders. 

TIP: Alternative, it is also possible to drag-and-drop the data files directly into the Main 
Menu window of the SureTrend software. 

If the imported file has the same name as an existing data file, you will be prompted to 
supply a new file name. This allows similar files from different sites to be imported 
without overriding the existing files. 

TIP: To import files received by email, first save the attachments to your hard disk. For 
example, to your desktop, and then import them into the software as detailed above. 

NOTE: If the data files have been supplied on CD-ROM, they may have read-only file 
properties, and will remain read-only when the files are imported. If this is a problem, 
use Windows Explorer to copy the files to your hard disk. Then change the file 

Properties to remove the Read-only attribute. Finally, import the files from the hard 
disk. 

2.8.3 Merging Results Database Files 

The database file from the older dataSURE II Data Analysis Software or SureTrend 
archive files can be merged into a SureTrend results database. This feature can be 
used to consolidate test results from multiple SureTrend installations into a single 
results database for reporting and analysis. This is achieved as follows: 

a) Import the dataSURE II database or SureTrend archive file in the manner 
described in section 2.8.2, giving it a new filename if necessary. 

b) Open the Archived Data window from the Navigator list. 

c) Select the dataSURE II database or SureTrend archive file from the file list. 

d) Select the Open option from the File menu. 

e) When prompted you have the option to append the data permanently, add the 
data temporarily, or to cancel the operation. If you add the data temporarily it will 
not be saved back to the results database. The next time the results database is 
opened the dataSURE II database or archive data will be removed. See section 
5 
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2.9 Communicating with the Unit 

When the Synchronise option is selected from the File menu, the following dialog 
window will appear. 

 

Connect the serial interface cable (supplied with the unit) between the luminometer and 
one of the RS232 or USB ports on your PC. Please refer to the Luminometer Operator’s 
Manual that came with the luminometer for details. 

Next, select the Serial Port from the drop-down list. If you are using the USB cable 
supplied with the luminometer you can select USB from the drop-down list. If you are 
using the optional serial cable you will need to know the COM port number where the 
serial cable is connected. You can use Windows Device Manager to help locate the 
available COP port. 

Switch on the luminometer and click on the dialog Connect button. 

If correctly connected, SureTrend will establish communications with the luminometer 
and automatically transfer the results and set-up data, as required. 

TIP: The SureTrend software can be configured to automatically connect with the 

luminometer when the Synchronise option is selected, without the need to click the 

Connect button. See section 9.5 for more details. 

2.9.1 USB Cable Installation 

The USB cable that shipped with the luminometer 
is the preferred cable type to connect to your 
computer. The USB cable requires the 
SystemSURE SMART USB Cable driver. The 
SureTrend software installation will automatically 
install the USB driver. The certified USB driver is 
also accessible from the Windows Update site. 

In rare cases the USB driver may report to 
Windows the USB cable is not operating properly. 
This usually means the computer needs a BIOS 
or USB bus driver update, or another USB device 
is in conflict. Refer to the computer manufacture or Microsoft support website for trouble 
shooting USB issues, or contact Hygiena customer service for assistance. 
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3 Main Menu 

When the SureTrend software is opened, the Main Menu window is displayed, which 
provides direct access to the primary software functions. 

Button Action Section 

 

Upload new test results data from the luminometer and 
store them in the Results Database and download 
program data 

4.4 

 

View the entire Results Database with the most recent 
test results data first 

4 

 

Run your Standard Report #1 on the Results Database 5.3 

 

Run the Failures Report on the Results Database 5.3 

 

Add a new luminometer Unit to the SureTrend software 0 

 

Save all data and exit the SureTrend software - 

 

TIP: The action of the Standard Report and Failures Report buttons can be configured 

via the software Preferences window. See section 9.4 for details. 

4 Results Database 

The Results Database window displays the contents of the test results database table, 
which maintains a history of every test result uploaded from the luminometers. 

 

New test results data is uploaded directly from one or more luminometers and stored in 
the Results Database. As each test result is stored along with the luminometer’s serial 
number, test time and date, and the sample location, it can be positively identified and 
data trends tracked. 

To prevent accidental or fraudulent manipulation of the test results in the database, 
data cannot be directly added, deleted or edited by the user. This protects the integrity 
of the uploaded data and eliminates 'selective amendments' or other ‘data abuse'. 
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4.1 Field Definitions 

Each individual test result record comprises of the following set of data fields. 

Column Field Data 

Index The overall  /  /  result icon and database record index number 

Date The date the test was performed 

Time The time the test was performed 

Unit# The serial number of the luminometer that performed the test 

User ID The ID of the User the performed the test 

Plan The Test Plan name 

Prog# The unit PROG number used for the test 

Location The Location name associated with the Unit# and Prog# 

Group The Group name associated with the Unit# and Prog# 

Surface The Surface name associated with the Unit# and Prog# 

Test Type The test type: Normal/Repeat Reading/Retested/Retest Result 

Result The overall Pass/Caution/Fail test result 

RLUs The test reading in RLUs 

Lower The lower () program threshold 

Upper The upper () program threshold 

Notes Additional field for optional related comments and notes 

 

The format of the Date and Time fields is defined in the software Preferences window. 
See section 9.3 for details. 

The User ID, Plan, Location, Group and Surface can be changed by selecting the 
luminometer from the Unit Set-up Data in the Navigator and then double-clicking on the 
value you want to change. Then either type the correct name or by selecting one from 
the drop-down list. 
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4.2 Test Types 

The Test Type field describes how the test was performed on the unit and how the 
result was derived. 

Test Type Reading Method 

Normal A normal Pass ( ), Caution ( ) or Fail ( ) test result, whereby the 
sample device was placed in the luminometer and read once only. 

Repeat Reading A repeat reading Pass, Caution or Fail result, whereby the sample 
device was placed in the luminometer and multiple reading taken by 
repeatedly pressing the  button without removing the sample device. 

Retested A Fail test result that has been subsequently retested and marked with 
the  icon on the luminometer display. 

Retest Result The Pass, Caution or Fail result of a retest, that is marked with the  
icon on the luminometer display. 

4.3 Editing the Notes Field 

The Notes field can be used to optionally annotate the test result records with 
additional user entered text, as required. Refer to section 2.5 for details. 

The following right-click menu options are available to the Results Database window. 

 

Synchronise: Upload new test results from the luminometer 

Statistics: Display statistical data for selected records. 

Edit 'Notes': Edit the Notes field of the selected records. 

Copy: Copy the selected data to the clipboard. 

Select All: Select all database records. 

Search: Search the database for the specified text. 

4.4 Uploading Test Results from the Luminometer 

Sample test results data is uploaded from the luminometer and stored in the Results 
Database file. Please refer to the Luminometer Operator's Manual for details of how to 
take sample measurements. 

WARNING: Please ensure that the associated Unit Set-up Data file has been created, 
fully configured, and downloaded to the unit. Also ensure that the date, time and date 
format on the luminometer are correct before taking any samples, otherwise potentially 
invalid or incorrect data will be uploaded to Results Database. See section 7 for details. 

To upload new test results data from the luminometer, connect the luminometer to the 

PC, select the Synchronise option from the File menu and click the Connect button. 
Refer to section 2.9 for further details. 

If correctly connected, the new test results will be uploaded from the luminometer and 
stored in the Results Database. 
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When the upload is complete, you can choose whether or not to erase the uploaded 
test results from the memory of the luminometer. 

 

If you choose not to automatically erase the results from the luminometer, they can be 
manually erased later. Refer to the Luminometer Operator's Manual for details. 

NOTE: The new test results data is automatically sorted into the Results Database in 
chronological (ascending date and time) order. Hence, if you are operating with several 
luminometers, the most recently uploaded data may not always appear at the end of 
the database table, depending on the date and time the tests were performed. 

Column sorting (see section 2.3) can therefore be used to sort and view the database 

contents in a more convenient order. For example, clicking on the Unit# heading will 
sort the test results by luminometer serial number, but still maintain the chronological 
sort order within each luminometer serial number. 

Likewise, clicking on the Result column heading once will sort the database in 

ascending order by the test result type, with the oldest Pass result first; clicking on the 
column heading again will sort the database in descending order with the most recent 

Fail result first. This could be useful for quickly reviewing the most recent Fail results 
without the need to specifically set-up and run a report. 

4.5 Previewing Statistical Data 

Statistical data can be displayed by selecting a range of database records (see section 

2.4) and then selecting the Statistics option from the Reports menu. 
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Each of the selected database records is then analysed and the following overall 
statistical data calculated and displayed. 

Statistic Displayed Data Equation 

Tests Total number of tests selected  n  

Passes Percentage and number of Pass results 
%

n

nPASS , PASSn  

Cautions Percentage and number of Caution results 
%

n

nCAUTION , CAUTIONn  

Fails Percentage and number of Fail results 
%

n

nFAIL , FAILn  

Normal Tests Number and percentage of normal test results 
NORMALn , %

n

nNORMAL  

Repeat Readings Number and percentage of repeat readings 
REPEATn , %

n

nREPEAT  

Fails Retested Number and percentage of failed results that 
have been retested FAILn , %

n

nFAIL  

Retest Results Number and percentage of retest results 
RETESTn , %

n

nRETEST  

Minimum Minimum RLUs reading MINx  

Average Average RLUs reading 

n

x
x


  

Maximum Maximum RLUs reading MAXx  

SD Standard Deviation 
(reports 0.0 if 2n ) 

 

 1

2




nn

xx
 

4.6 Preview Chart 

The Preview Chart also displays this statistic data in one of three graphical forms. 

 Results 

 

Green: Percentage Passes 

Yellow: Percentage Cautions 

Red: Percentage Fails 

 Test Types 

 

Blue: Number of Normal Tests 

Purple: Number of Repeat Readings 

Red: Number of Failed Test Retests 

Orange: Number of Retests Performed 
 RLUs 

 

Blue: RLUs 

Grey: Average RLUs 

Scale: Minimum RLUs to Maximum RLUs 

TIP: When you move the mouse pointer over the Preview Chart, the value of the pie 
segment or line point under the pointer is displayed. For example; . 
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5 Archived Data 

The Archived Data window provides a list of all database archive files and imported 
dataSURE II Database files. 

 

TIP: This list also includes the actual SureTrend Results Database file itself. This allows 
the database file to be exported and shared with other sites. See section 2.8. 

5.1 Creating a New Database Archive File 

The Results Database stores every test result ever uploaded from the luminometer, it 
can become very large and potentially unmanageable. It is recommended that older 
data be archived to keep the Results Database manageable. The Results database can 

be archive by selecting the Results Database window from the Navigator list, and then 

selecting the Create Archive File option from the File menu. This will bring up the 

Archive Wizard. 

5.1.1 Starting the Archive Wizard 

 

The wizard will then guide you through the 
simple steps required to archive data in the 
Results database. 

NOTE: Once test results data has been 
remove from the main database it can only be 
accessed by opening the associated archive 

file from the Archived Data window. See 
section 5.1.2 below for further details. 
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5.1.2 Step 1 Select the data archiving method 

 

 Option 1: Select this option to archive all 
test results from the beginning of the 
database up to (and including) the date you 
specify. 

 Option 2: Select this option to archive all of 
the test results data and leave the database 
completely empty. 

5.1.3 Step 2 Select the archive file comment 

 

You may include an additional text comment, 

which will appear in the Notes column on the 

Archived Data window. 

Then click the Finish button to save the new 
archive file. 

 

5.2 Opening an Archived Data File 

To reopen an Archived database file, simply select the file from the Archived Data list, 

and then select the Open option from the Files menu. When prompted select the 
option to permanently or temporarily add the archive data back to the Results 
Database. 

The archived data will then be read back into the Results Database. If the archived data 
is displayed with its record result icons greyed-out ( ) the archive data is 
temporary and will not be in the Results Database next time it is opened.  If the results 
icons are the normal green, yellow, and red then the archive data is added 
permanently. 

The included archive data can now be re-analysed using the report generator. 
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5.3 Report Generator 

The Reports window lists all the report set-up files and report output data files. 

 

The report files types are distinguished by file icon and background color. 

File Icon File Type Background Color 

 Report Set-up File White 

 Report Output Data Pale blue 

 

The report generator allows standard reports to be defined and regularly run, to 
produce consistently formatted report charts and data, which can be printed or stored 
for review at a later date. 

These reports can also include trending analysis, allowing several consecutive time 
periods to be compared on a single report chart. Refer section 5.9 for details on data 
trending. 

The following right-click menu options are available for the Reports window. 

 

Set-up Report: Modify the selected report set-up file ( ) 

Generate Report: Create a new report output file from the selected 
report set-up file ( → ) 

Open: Open the selected report output data file ( ) 

Refresh: Refresh the report file list. 

Edit 'Notes': Edit the 'Notes' field of the selected files. 

Copy: Copy the selected data to the clipboard. 

Delete: Permanently delete the selected report file. 

Select All: Select all report files. 

Search: Search the list for the specified text. 

 

TIP: The SureTrend software is pre-loaded with numerous typical report types. These 
can be used as is; copied and modified; or new reports set-up. See sections 5.4 and 
5.8 for details. 
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5.4 Generating a New Report Output File 

A new report output data file is generated by selecting the required report set-up file ( ) 

from the Reports window file list, and then selecting the Generate Report option from 

the Reports menu. 

5.4.1 Starting the Report Wizard 

 

The wizard will then guide you through the 
steps required to run the report and generate 
the output data file. 

NOTE: Some reports do not need to perform 
all of the wizard steps, as the required input 
data is already pre-defined in the report set-
up file or is not relevant to the type of report. 
In this case the unneeded steps are 
automatically bypassed.  

5.4.2 Step 1 Select the report name 

 

Enter the name of the new report output data 
file. This name must be unique to the Reports 
list. 

 Do Not Save Data: Check this option if you 
do not wish to save the output data to disk. 
This will save disk space but does prohibits 
the report output data from being reviewed at 
a later date without generating a new report. 

5.4.3 Step 2 Enter the report time period 

 

 Report Time Period: Select the report time 
period from the drop-down list. 

 Data Trending: Select the number of 
report data trending periods required. 

 Start and End Date: Select the start and/or 
end date of the total time period, as required. 

See below for further details. 

TIP: The report toolbar buttons ( , ,  or ) can also be used. Refer to section 9.4 for 
details of how to configure these buttons to select your four most frequently used 
reports. 
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Report Time Periods 

The possible report time periods and durations are as follows. 

Time Period Period Duration Data Trending Periods 

None 100 years (all data) None (1 period) 

Specific Set by Start and End date None (1 period) 

Daily 1 day None (1) or 2 to 14 periods 

Weekly 7 days None (1) or 2 to 14 periods 

Monthly 1 calendar month None (1) or 2 to 14 periods 

Quarterly 3 calendar months None (1) or 2 to 14 periods 

Yearly 1 calendar year None (1) or 2 to 14 periods 

 

Generally, the End Date of the final time period is specified (e.g. "Week Ending") and 

the Start Date is automatically calculated (from the Time Period multiplied by the 

number of Data Trending periods). Refer to section 5.9 for details of data trending. 

NOTE: Some reports may also be set-up with a predefined Time Period or number of 

Data Trending periods, in which case these values are pre-selected and cannot be 
altered. 

5.4.4 Step 3 Enter report specific data 

 

If necessary, additional report-specific data 
may be required. This will normally be a 
single value (such as a Location), but could 
also be a range of values (such as a 
particular Prog# range). 

 Value: Type in the required value or select 
one from the drop-down list. 

If more than one set of values are required, 
this step is repeated for each prompted value. 

5.4.5 Step 4 Select the report output file comment 

 

You may include an additional text comment, 

which will appear in the Notes column on the 

Reports window. 

NOTE: This is not required if the Do Not 

Save Data box is checked in wizard Step 1. 

Then click the Finish button to generate the 
new report output data. See section 5.5 for 
details. 
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NOTE: Depending on the size of the Results Database and the complexity of the report 
set-up, the report generator may take between a few seconds and a couple of minutes 
to filter, analyse and sort the results data to create the report output data. 

5.5 Reviewing and Customizing the Report Output 

Having generated a report, it can reopened by selecting the report output data file ( ) 

from the list on the Reports window and then selecting the Open option from the File 
menu. 

The report output file is then added to the Navigator list as a sub-item under Reports, 
and has three data elements 

 

 Additional Notes 

 Report Chart 

 Report Data table 

5.5.1 Additional Notes Editor 

Clicking on the report output name in the Navigator list, displays the report Additional 

Notes text editor window. 

 

This simple text editor can be used to add any additional text information to the report 
output file, and printed if necessary. 

5.6 Report Chart 

Clicking on the Report Chart item in the Navigator list, displays the report output chart 
window. 
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When you move the mouse pointer over the Report Chart window graph area, the 
value of the data point under the pointer is displayed. 

 

TIP: If you double-click on the data point, you will be taken to the corresponding data 

row in the Report Data window. Double-clicking on other rows will display the 
associated Statistical data. 

Right-clicking on the chart area provides the following context menu options. 

 

Copy: Copy the chart bitmap to the clipboard. 

Legends: Show/hide the legends box. 

Markers: Show/hide line graph point markers. 

Annotation: Show/hide the data value boxes. 

Trend Lines: Show/hide line graph least-squares line fit. 

Properties: Open the chart customization wizard. 

 

The chart appearance can be changed by selecting the Properties option from the 
right-click context menu. 

 

Modify report chart details... 

This mini-wizard allows customization of: 

 The chart style 

 Chart title 

 Y-axis and X-axis labels 

 Y-axis traces, colors and names 

 Y-data value display 

Refer to section 5.8 step 3 for full details of 
the available options. 
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5.7 Report Data Table 

Clicking on the Report Data item in the Navigator list, displays the report data table 
window. 

 

Right-clicking on the table data provides the following context menu options. 

 

Statistics: Display statistical data for selected rows. 

Export: Export the data table to a Microsoft Excel file. 

Copy: Copy the select data to the clipboard. 

Select All: Select all table rows. 

Search: Search the table for the specified text. 

Properties: Open the data table customization wizard. 

TIP: For statistical data, where each output row that was generated from the analysis 
and combination of several database records, double-clicking on the table row will open 

the Statistics dialog window (see section 4.5) with a graph showing each of the original 
database data points. 

TIP: Using the Export option from the File menu allows the entire contents of the data 
table to be saved as a Microsoft Excel file. See section 2.8.1 for details. 

The format of the table's rows and columns are pre-defined by the report set-up file, 
according to the desired report data style and contents. This can be customised by 

selecting the Properties option from the right-click context menu. 

 

Modify report data table... 

This mini-wizard allows customization of: 

 Which data Fields are included 

 The arrangement of the columns 

 Column data sorting 

Refer to section 5.8 step 4 for full details of 
the available options. 
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5.8 Creating a New Report Set-up File 

To create a completely new report set-up file, select the Create New Report options 

from the Reports menu. Otherwise, to modify an existing Report Set-up file, select the 

file from the Reports list and then select the Set-up Report option from the Reports 

menu. This will bring up the Report Set-up Wizard. 

5.8.1 Starting the Wizard 

 

The wizard will then guide you through the 
steps required to set-up a new report or 
change an existing set-up file. 

NOTE: Wizard Steps 2, 3 and 4 are only 

required if the Advanced Set-up box is 
checked in wizard Step 1, otherwise these 
set-up parameters are configured 
automatically and the Advanced Set-up 
wizard steps are bypassed. 

5.8.2 Step 1 Select the report name and style 

 

Enter the name of the new report set-up data 
file. This name must be unique to the Reports 
list. 

 The other set-up parameters define: 

 Time period and data trending of the 
report 

 How the database results are filtered 
and analysed 

 Style of the report chart and data table 

See below for more details. 

 

NOTE: Some combinations of these set-up parameters can produce peculiar or 

meaningless report charts, or may fail to create any output data at all. The Report 

Period defines the time period of the report, such that only those database test results 
that fall within this period are included in the report analysis and output. 
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The following are the report time periods. 

Time Period Period Duration 

None The start and end dates are those of all the data in the test Results Database 

Specific The start and end dates are defined by the user when the report is run 

Daily 1 day 

Weekly 7 days 

Monthly 1 calendar month 

Quarterly 3 calendar months 

Yearly 1 calendar year 

Custom… Any of the above (selected by the user when the report is run) 

 

For Daily, Weekly, Monthly, Quarterly, Yearly and Custom time periods, a number of 

consecutive Data Trending periods can also be set specified, as follows. Refer to 
section 5.9 for further information about data trending. 

Data Trending Allowable Trending Periods 

None No trending (single Time Period only) 

2 to 14 Between 2 and 14 consecutive time periods, allowing report durations 
such as: 
5, 7 or 14 days 
2, 4, 8 or 12 weeks 
3, 4, 6 or 12 months 
2 or 4 quarters 

Custom... Any of the above (selected by the user when the report is run) 

 

The Test Results Selection option defines the primary database test results filtering. 

Selection Database Filtering Performed 

All test Results None 

Passes only 

Cautions only 

Fails only 

Data records are selected according to the test Result field: Pass, 
Caution or Fail 

Fails and Retests Data records are selected according to the Test Type field: Retested 
or Retest Result (see section 4 for Test Type descriptions) 
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The Specific Data Selection option defines whether the user is required to select a 
specific data field value when the report is run. 

Specific Data Database Filtering Performed 

None None (no additional filtering performed) 

Unit# 

User ID 

Test Plan 

Prog# 

Location 

Surface 

Group 

When the report is run, the user must select a value for 
the specified database record field. 

Only those database test results that relate to the 
selected field value will be included in the report 
analysis and output.  

 

The Data Analysis option defines how the filtered data is analysed for each data 
trending period to produce a more concise set of report output data values. 

Data Analysis Chart X-Axis Data 

None Chronologically (all filtered data is output) 

Summary The data is combined into a single set of statistical 
values (see section 4.5) 

Time of Day Hour: 12AM, 1AM, 2AM, 3AM, etc  

Date Individual dates (chronologically) 

Day of Week Day: Sun, Mon, Tue, Wed, Thu, Fri, Sat 

Week Calendar week date (chronologically) 

Month Calendar month date (chronologically) 

Unit# 

User ID 

Test Plan 

Prog# 

Location 

Surface 

Group 

Unit serial number 

User ID name 

Test Plan name 

Prog# number 

Location name 

Surface name 

Group name  

Test Type 

Result 

Test Type (see section 4) 

Result type (Passes, Cautions and Fails) 
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The Report Chart Data option defines what data appears on the Y-axis of the Report 
Chart, and the style of chart (see step 3). 

Chart Data Style Y-Axis Data  

Tests Performed Bar Number of test results 

Passes Bar Number of Pass results 

Cautions Bar Number of Caution results 

Fails Bar Number of Fail results 

Results Pie Number of Pass results 

Number of Caution results 

Number of Fail results 

Percentage Results Pie 

or 

Stacked 

Percentage of Pass results 

Percentage of Caution results 

Percentage of Fail results 

Test Types Pie 

or 

Bar 

Number of Normal test result 

Number of Repeat Reading results 

Number of Retested Fail results 

Number of Retest results 

RLUs Line RLUs (or average) 

RLUs with thresholds Line RLUs (or average) 

Lower thresholds (or average) 

Lower thresholds (or average) 

Min / Average / Max Linked Minimum RLUs 

Average RLUs 

Maximum RLUs 

 

The Report Data Table options define what data is included in the Report Data table. 

Table Type Data Fields Included 

Chart Data As per chart output traces (see below) 

Database Data All database fields (see section 4) 

Statistical All statistical data values (see section 4.5) 

Custom As defined by wizard Step 4 (see below) 
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Advanced Set-Up 

 Advanced Set-up: Normally the set-up options for wizard Steps 2, 3 and 4 are 
automatically pre-defined by the options specified in Step 1. However, checking this 
option allows those setting to be overridden and a more tailored report output to be 
defined. 

5.8.3 Step 2 Define custom data selection. 

 

Field Filtering: This specifies how the 
database records are filtered. See below for 
details. 

Remove: Deletes the selected filter condition. 

Modify: Opens the Filter Criteria definition 
window for the selected database field. 

See below for further details. 

Filtering Conditions 

The Filter Conditions list shows the database Field (see section 4) and the associated 

Filtering condition. 

The filter condition can be modified by double-clicking on the required field row, or by 

selecting the row and clicking the Modify button. This brings up the specific Filter 
Criteria definition window. 
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The Filter Criteria table has the following field and button options. 

Field/Option Purpose 

Condition The comparison to be made when filtering the data (see below) 

Custom No:  The Value (and Range) is pre-define by this condition 
Yes: The Value is specified by the user when the report is run 

Value The value against which the data is compared 

Range The limit value against which data is compared 

Remove Remove the selected filter criteria 

New Add a new filter criteria 

Exclude... Exclude (rather than include) all data which matches this filter 

OK Accept any changes made to the filter definition and exit 

Cancel Discard any changes made to the filter definition and exit 

 

The Condition defines how the database record field data is compared against the 

Value and Range values. The available conditions depend upon the database Field 
type. 

Field Value Conditions Range 

Index Equals / Not equals / Less than / Greater than In the range 

Date Equals / Not equals / Before / After Between 

Time Equals / Not equals / Before / After Between 

Unit# Equals / Not equals / Less than / Greater than In the range 

User ID Equals / Not equals / Contains  

Plan Equals / Not equals / Contains  

Prog# Equals / Not equals / Less than / Greater than In the range 

Location Equals / Not equals / Contains  

Group Equals / Not equals / Contains  

Surface Equals / Not equals / Contains  

Test Type Equals / Not equals  

Result Equals / Not equals  

RLUs Equals / Not equals / Less than / Greater than In the range 

Lower Equals / Not equals / Less than / Greater than In the range 

Upper Equals / Not equals / Less than / Greater than In the range 

Notes Equals / Not equals / Contains  

 

TIP: Time ranges can be specified such that the first Value is later then the second 

value in the Range to include the midnight rollover. For example: Between 17:00 and 

8:30. 
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To add a new filter Condition, click on the New button, select the Condition type from 

the drop-down list, then enter the Value (and Range, if applicable). 

TIP: For Custom values (i.e. data that must be specifically entered by the user when 

the report is run - see section 5.4 step 3), use the default data Values and then double-

click on the Custom column value to change it from No to Yes. 

NOTE: All dates and times must be entered in the format specified by the Time and 

Date Format in the software Preferences window (see section 9.3). 

The Exclude all matching data option can be useful if you want to exclude specific 
test results from your analysis. For example, if you have QC test results which all have 
the letters "QC" in the Group name, you can set-up the filter to "Exclude all data for 
Groups containing QC". 

 

If more than one Condition is defined, a logical OR is performed. For example, the 

following would be read as "Before 1/02/2007; OR Between 1/04/2007 and 30/04/2007; 

OR After 31/05/2007". 

 

Conversely, when more than one Field Filters are defined, a logical AND is performed. 

For example, the following would be read as "Between 1/01/2004 and 21/12/2004; AND 
Between 9:00 and 17:00". 

 

5.8.4 Step 3 Select report chart details 

 

 Chart Style: Selects the chart type: Line, 
Bar or Pie. See below for examples. 

Title and Text: Optional text for the chart title, 

and the x-axis and y-axis labels.  

Chart Data: Selects the chart data, colors 
and legend names. See below for full details. 

 Display Data: Check this option to 
annotate the chart with all of the chart y-axis 
data values. 
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Chart Styles 

The Chart Style selects the way in which the data is presented on the chart. 

Example Chart Style and Data 

 None: No chart is generated 

 

Line: 

Related data points horizontal joined by lines 

 

Linked: 

Related data points linked by vertical lines 

 

Bar:  

Related bars, grouped side-by-side 

 

Stacked Bar: 

Related bars, stacked on top of each other 

 

Pie: 

Related pie segments in one pie 

The x-axis type and data is pre-determined by the Data Analysis option in wizard step 

1 above. The chart y-axis data series are defined by the Chart Data list, which allows 
the chart y-axis data fields, colors and legend text to be selected and customized. This 
is done by right-clicking on the required list item and then selecting the appropriate 
option from the following context menu. 

 

Field Name: This is the data table field name. 

Visible: Show/hide the selected data series. 

Edit Text: Edit the data series legend name. 

Change Color: Select the color of the data series. 

Restore: Reset the series name and color settings. 
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5.8.5 Step 4 Select the report data table contents. 

 

Field Sorting: This defines which data Fields 
are including in the Report Data table, the 
order in which they appear, and how each 
column is to be sorted. See below for details. 

 Transpose Table: Check this option to 
swap-over the data table rows and columns - 
thus turning a short-wide table into a long-thin 
table. 

 

 

The data fields are displayed in the Report Data table in the order they are listed in the 
selection table (see above). To change the order of the columns, select a field from the 

list and then use the Move Up and Move Down buttons to reposition the column within 
the table.  

Use the Check box next to the Field name to add or remove it from the data table. 

The Sorting method defines the way in which the Field data is sorted. This is changed 

by selecting the field row, clicking the Sorting button, and then selecting the new 
sorting method from the drop-down list: 

Sorting Method Data Order 

None As defined by the Data Analysis setting in Step 1 

Ascending order (0-9, A-Z) Lowest values first 

Descending order (Z-A, 9-0) Highest values first 

 

5.8.6 Step 5 Select the report set-up file comment 

 

You may include an additional text comment, 

which will appear in the Notes column on the 

Reports window. 

 Run Trial Report: Check this option to try 
out the new report set-up by running a trial 
report without saving the report output data. 

Then click the Finish button to save the new 
report set-up file to disk. 
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5.9 Report Data Trending 

The report can be set-up to include data trending, whereby the report output data for 

the specified report Time Period is compared against two or more data sets of the 
same time span, and displayed on the same chart. 

For example: The previous five days’ worth of Pass, Caution and Fail test results can 
be directly compared against each other by creating a report with the following settings. 

Report Period: Daily Report 

Data Trending: 5 Periods 

Test Result Selection: All Test Data 

Specific Data Selection: None (All data) 

Data Analysis: Summary (Combined) 

Report Chart Style: Percentage Results 

Report Data Table: Statistical 

 

The overall duration of the report is determined as the Report Period interval multiplied 

by the number of Data Trending periods. In this case "Daily" times "5" = "5 Days". 

Running this report would produce typical Report Charts, such as: 

   

Bar Stacked Pie 

 

The five data trending periods are represented on the chart as [A], [B], [C], [D] and [E].  

TIP: The period colors are slightly graduated, with the most recent data [A] appearing 
the lightest and brightest, and the oldest data [E] appearing the dullest. 
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The associated output data table for this report would be as follows. 

 

6 User IDs 

The User IDs window displays the table of up to 50 User names, which can be stored in 
the luminometer. 

 

The single User IDs list is common to all of the units that have been added to the 
SureTrend software. Hence, if you change the User ID list, you should download it to all 
of your luminometers. 

NOTE: User IDs are not support by the SystemSURE II unit. 

The User ID field is limited to 16 characters. Please refer to the Luminometer 
Operator's Manual for detail of how to select the User ID on the luminometer. 

TIP: If longer user names are required, you could use the User ID field for the user's 

Initials and the Notes field to store their full name. 

To add or change a single User ID, simply double-click on the required cell and type in 
the new name, or select one from the drop-down list. 

To add or change several User IDs, you can select a range of rows and then select the 

Edit User ID option from the right-click context menu. 
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Synchronise: Download the User IDs list to the luminometer. 

Edit User ID: Edit the User ID field of the selected rows. 

Edit 'Notes': Edit the Notes field of the selected rows. 

Copy: Copy the selected data to the clipboard. 

Delete: Remove the selected User IDs. 

Select All: Select all User ID rows. 

Search: Search the User ID list for the specified text 

 

7 Unit Set-up Data 

The Unit Set-up Data window provides a list of unit set-up data files, one for each 
luminometer added to the SureTrend software. 

 

Each Unit Set-up Data file consists of a set of up to 5001 Program Locations and Result 
Thresholds, plus up to 100 associated Test Plans. Each Test plan can have up to 251 
Program Locations. 

NOTE: Refer to the Luminometer Operator’s Manual for the maximum Program 
Locations and Test Plans your luminometer will support. 

To modify the set-up data for a particular luminometer, simply double-click on the Unit# 

in the Title column to open the data file. Refer to section 7.3 for further details. 

TIP: The file list can be sorted by clicking on the appropriate column header. See 
section 2.3 for details. 

If the Unit# is displayed in RED text, it indicates that the set-up data stored in the 
associated luminometer is now out-of-date, and can be updated by right-clicking on the 

Unit# and then selecting the Synchronise option from the context menu. 
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Add New Unit: Create a new unit set-up file (see section 0). 

Open: Open the selected unit set-up data file. 

Synchronise: Write the set-up data to the unit. 

Refresh: Refresh the Unit Set-up Data file list. 

Edit 'Notes': Edit the Notes field of the selected set-up file. 

Copy: Copy the selected data to the clipboard. 

Delete: Erase the selected set-up file. 

Select All: Select all unit set-up files. 

Search: Search the table for the specified text. 

 

7.1 Adding a New Unit 

To add a new Unit Set-up Data file to the SureTrend software, select the Add New 

Unit option from the Set-up menu. This will bring up the New Unit Wizard. 

7.1.1 Start the New Unit Wizard 

 

The wizard will then guide you through the 
steps required to add a new luminometer. 

NOTE: To add a new unit from data files 
already supplied to you on CD-ROM or by e-

mail, click the Import... button at the bottom 
of the dialog window, and then refer to 
section 2.8 for further details. 

7.1.2 Step 1 Select the unit set-up method 

 

 Option 1: Select this option to 
automatically read the new unit's serial 
number and set-up data by connecting the 
unit to the PC's serial port and clicking the 

Next > button. 

 Option 2: Select this option if you wish to 
manually specify the unit serial number and 
model type, or copy the set-up data from an 
existing unit. 

 



39 

TIP: To add a luminometer that has already been set-up with Program data (such as an 

older systemSURE II unit), select Option 1 to automatically upload the set-up data from 
the unit. 

TIP: To duplicate the set-up data of an existing unit, select Option 2, enter the New 
Unit#, and then select the Existing Unit# from the drop-down list. 

7.1.3 Step 2 Select the set-up file comment 

 

You may include an additional text comment, 

which will appear in the Notes column on the 

Unit Set-up Data window. 

Then click the Finish button to save the new 
set-up data. 

7.1.4 Unit Properties 

You can determine the luminometer properties including model, version and capacity by 

Right Clicking on the Unit# in the Navigator list and select Properties… from the 
content menu. The following windows will appear. 

 

Depending on the model type, the unit will have the following storage capabilities: 

Storage Feature EnSURE V2 

SystemSURE Plus V2 

EnSURE 

SystemSURE Plus 

SystemSURE II 

User IDs 200 users 50 users Not supported 

Program Locations 5001 (0-5000) 251 (0-250) 100 (0-99) 

Location Names 20 characters max 20 characters max Not supported 

Test Plans 100 plans 20 plans Not supported 

Results Memory 2000 tests 2000 tests 500 tests 
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7.2 Writing the Set-up Data to the Luminometer 

To download the Unit Set-up Data to the luminometer, open the Unit Set-up Data file 

(see section 7.3) and select the Synchronise option from the File menu. Refer to 
section 2.9 for further connection details. 

The software will then download the following unit set-up data to the luminometer, 
depending on its model type and capabilities. The following shows the data available by 
luminometer model and version. 

Set-up Data EnSURE andSystemSURE Plus 

(all versions) 

SystemSURE II 

User IDs   

Location Names   

Program Thresholds   

Test Plans   

 

WARNING: This will overwrite all of the set-up parameters currently stored in the 
luminometer. Once overwritten, the old values cannot be recovered. 

7.3 Program Locations and Result Thresholds 

For each luminometer the SureTrend software maintains a table of programmable 
sample locations, associated test result thresholds, group names, surface names and 

notes. When you open a Unit# data file from the Unit Set-up Data window (see 7 for 
details), the unit’s Program Data table is displayed. 
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Each table row in the Unit Set-up Data window represents a different Prog# location. 
Key fields associated with the row are downloaded to the luminometer. These fields will 
be visible on the luminometer. Other fields are for reference and reporting and will not 
be visible on the luminometer.  The following is a list of fields and their visibility on the 
luminometer. 

Field 

Name 

Description Visible on 

Luminometer 

Prog# The PROG number, as used on the luminometer. Refer to the 
Luminometer Operator's Manual for details. 

Yes 

Location The location name (of up to 20 characters) associated with the 
PROG number. This name will appear in the database record 
listing when new test results are uploaded from the luminometer. 

Refer to section 4.4. NOTE: If Bold mode is enabled it is possible 
to have a location name of 20 characters that can’t be displayed 
completely on the luminometer screen. You can disable Bold 
mode to allow for the full 20 characters to display. 

Yes 

Group An optional group name (of up to 50 characters) which can be 
used to categorise the location into a further sub/super group. This 
name also appears in the database record listing when new test 
results are uploaded from the luminometer. Refer to section 4.4. 

No 

Surface An optional surface name or type (of up to 50 characters) which 
can be used to further categorise the location. This name also 
appears in the database record listing when new test results are 
uploaded from the luminometer. Refer to section 4.4. 

No 

Lower The program lower () threshold, as defined on the luminometer. 

This data is sent to the luminometer to define its programmable 
result thresholds. Refer to section 7.2 

Yes 

Upper The program upper () threshold, as defined on the luminometer. 
This data is sent to the luminometer to define its programmable 
result thresholds. Refer to section 7.2 

Yes 

Notes Additional comments text, as required. No 

 

The value of program Location, Group and Surface names, and the Lower and 

Upper threshold values are all editable. See section 2.5 for additional information. 

TIP: Prog#0 has a special function, whereby its Lower and Upper threshold values are 

used as the default values when setting-up all of the other Prog# thresholds. Thus, 

setting Prog#0 with your typical threshold values may save time when setting-up the 
other program locations that have similar threshold values. 

NOTE: Please refer to the Luminometer Operator's Manual for details of how the 
Programmable Result Thresholds are used on the unit, and how they are applied to the 
sample test RLU reading to give an overall Pass, Caution or Fail result. 
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The following right-click context menu options are available. 

 

Synchronise: Write the set-up data to the luminometer. 

Add New Test Plan: Add a new test plan (see section 7.5). 

Edit Data: Edit all of the data fields in the selected 
Prog#s. 

Edit 'Notes': Edit the Notes field of the selected Prog#s. 

Copy: Copy the selected data to the clipboard. 

Paste: Paste the copied data back into the data table 

Delete: Erase the contents of the selected Prog#s. 

Select All: Select all Prog# rows. 

Search: Search the table for the specified text. 

 

NOTE: If a program Location name, or Lower or Upper threshold value is changed, 
the new set-up data must be written back to the luminometer to keep it up-to-date (see 

section 7.2). Hence, the program data table is displayed with RED text to warn you that 
the data held on the associated luminometer is now out-of-date.  

7.3.1 Advanced Copy and Paste Functions 

The Edit menu allows the program data to be copied and pasted, enabling initial default 
values to be quickly set-up or the same set-up values to be duplicated across several 
units. 

To copy a complete row of data, select the row by clicking on it, then select the Copy 

option from the Edit menu. 

TIP: Several rows can be selected by holding down the Ctrl key and clicking individual 

additional rows, or by holding down the Shift key and clicking a range of rows. Refer to 
section 2.4 for details. 

To paste the copied data back into the table, select either a single row, several rows or 

all rows, and then select the Paste option from the Edit menu. 
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Some typical copy and paste operations are. 

Operation Copy/Paste Sequence 

Copy a single row of program data to 
another location. 

Select row to be copied 

Select the Copy option 

Select row to be replaced 

Select the Paste option 

Duplicate a single row of data to all other 
data rows in the table. 

 

Select row to be copied 

Select the Copy option 

Select the Select All option 

Select the Paste option 

Copy several rows of program data to 

another location. Note: The copy and 
paste selections must both be the same 
size. 

Select rows to be copied 

Select the Copy option 

Select rows to be replaced 

Select the Paste option 

Duplicate one unit's program data to 
another unit. 

Open the Unit# to be copied 

Select the Select All option 

Select the Copy option 

Open the Unit# to be replaced 

Select the Select All option 

Select the Paste option 

 

7.4 Sample Test Plans 

The luminometer can be programmed with up to 100 individual sample Test Plans, 
each consisting of a sequence of up to 251 program locations, listed in the order in 
which they would normally be tested. 

NOTE: Test Plans are not supported by the systemSURE II unit, and older 
luminometers will only support 20 test plans. Refer to the Luminometer Operator’s 
Manual that came with the luminometer for more details. 

A new unit set-up file initially contains no associated test plan data. Each test plan must 

be added and configured using the Add New Test Plan option from the Set-up menu 
(see section 7.5). 

As each new test plan is added to the unit, it is listed under the associated Unit# 
program data in the Navigator list. 
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NOTE: The Test Plan sequence table stores a list of Prog#s only. The Location, 

Group and Surface names associated with each Prog# are shown purely for reference 
and cannot be directly edited, as they are common to all Test Plans for a particular 
luminometer. 

Refer to section 7.6 for details of how to modify the test plan Prog# sequence list. 

The following right-click context menu options are available. 

 

Synchronise: Download the set-up data to the luminometer. 

Cut: Move the selected test plan steps to the clipboard. 

Copy: Copy the selected test plan steps to the clipboard. 

Paste: Insert the copied/cut test plan steps at the selected 
point. 

Delete: Remove the selected test plan steps. 

Select All: Select all test plan steps. 

Search: Search the list for the specified text. 

 

7.5 Adding a New Test Plan 

To add a new test plan to the luminometer, select the Add Test Plan option from the 

Set-up menu. This will bring up the Test Plan Wizard. 

7.5.1 Start the New Test Plan Wizard 

 

The wizard will then guide you through the 
steps required to add a new test plan to the 
unit. 
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7.5.2 Step 1 Select the new plan name 

 

First enter the name of the new test plan, 
which must be unique to that unit. 

This is the name that will appear on the 
luminometer display when selecting the Test 
Plan. 

 

NOTE: Older luminometers will not display the Test Plan name is all cases. Refer to the 
Luminometer Operator’s Manual that came with the luminometer for more details. 

7.5.3 Step 2 Select the initial plan data 

 

 Option 1: Select this option to create a 
new empty test plan to which program 
locations can be added later. 

 Option 2: Select this option to create a 
new test plan with all the unit program 
locations pre-selected. 

 Option 3: Select this option to create a 
copy of an existing test plan that can then be 
modified. 

 

NOTE: When using Option 2, only the first 251 locations will be selected. 

7.5.4 Step 3 Select the initial program locations 

 

Finally the program list can be modified: 
locations added, removed and reordered. 

Then click the Finish button to save the new 
test plan data. 

NOTE: The test plan can be further modified 
later. See section 7.6 below for details. 
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7.6 Changing an Existing Test Plan 

The test plan data table contents cannot be directly edited, as it simply stores a list of 
Prog#s. The associated Location, Group and Surface details are as defined in the 
Program data list for the associated Prog#. Refer to section 7.6 for details. 

WARNING: You should always finish setting-up all of the program data before starting 
to define the test plan sequences. This is important as each test plan is linked directly 
back to the program data table. 

A test plan can be modified as follows. 

Required Action Steps Performed 

Add new program 
locations to the test 
plan sequence 

Select the Unit# window from the Navigator. 

Select required Prog# locations. 

Select the Copy option from the Edit menu. 

Select test Plan# window from the Navigator. 

Select the position in the list where you wish to place the new 
locations. 

Select the Paste option from the Edit menu. 

Delete program 
locations from the test 
plan sequence 

Select test Plan# window from the Navigator. 

Select the Prog# locations you wish to remove from the list. 

Select the Delete option from the Edit menu. 

Change the order in 
with program location 
appear in the test 
plan sequence 

Select test Plan# window from the Navigator. 

Select the Prog# locations you wish to move. 

Select the Cut option from the Edit menu. 

Select the position in the list where you wish to place the removed 
locations. 

Select the Paste option from the Edit menu. 

  

7.7 Renaming a Test Plan 

To change the name of a Test Plan, right-click on the plan name in the Navigator list, 

then select the Rename option and type in the new test plan name: 
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7.8 Deleting a Test Plan 

To delete a Test Plan from the unit set-up data, right-click on the plan name in the 

Navigator list and select the Delete option: 

 

8 Technical Support 

The Technical Support window provides direct access to Hygiena’s online Technical 
Support and Documentation Internet pages. 

NOTE: This feature requires an active Internet connection. 

9 Software Set-up Preferences 

The SureTrend software set-up window is opened by selecting the Preferences option 

for the Set-up menu. The numerous set-up options are arranged into groups, and are 
explained in detail in the following sections. 

Options Group Section 

Password Protection 9.1 

General Options 9.2 

Time Format 9.3 

Date Format 9.3 

Report Set-up and Printing Options 9.4 

SystemSURE Unit Communications Options 9.5 

SureTrend Data File Options 9.6 

 

If any of the set-up options are modified, you must save the changes before they will 

take effect, by clicking the Apply button at the bottom of the Preferences window. 

 

NOTE: Certain set-up options require the SureTrend software to be restarted in order 
for the new setting to take effect. This is automatically performed when necessary. 
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9.1 Password Protection 

The password protection options provide a level of Administrator control, to protect the 
SureTrend data from unauthorized or accidental modification and deletion. 

 

 Restrict Software Functions: Each of the following SureTrend software functions can 
be individually selected to prevent the user from modifying the results database, reports 
or unit set-up data. 

Function Protection Against Section 

 Data Synchronisation Luminometer data interchange  4.4 

 Database Text Editing Editing of database text fields 4 

 ‘Notes’ Field Editing Editing of any ‘Notes’ fields 2.5 

 Database Archiving Archiving of Database test results data 5 

 Archive File opening Importing Archived results into the Results Database 5 

 Data File Importing Importing of data files from other sites 2.8 

 Data Exporting Exporting of data  2.8.1 

 Data File Deletion Deletion of any SureTrend data file  

 Report Set-up Creation or modification of report set-up files 5.3 

 Report Generation Generation of new report output 5.3 

 User ID Set-up Modification of the USER ID list 6 

 Unit Data Set-up Modification of Program and Test Plan data 7 

 

The associated protection password is set or 

changed by selecting the Password option from 

the Set-up menu: 

NOTE: If you forget the password, please contact 
your local distributor for assistance. 

Thereafter, attempting to perform any of the 
above protected software functions will display 
the following password dialog. 
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TIP: The protected function can be temporarily 
unlocked (unprotected) by checking the check 
box. The function can then be freely used without 
having to enter the password each time, and will 
become protected again next time the SureTrend 
software is run. 

9.2 General Options 

The following general set-up options are available. 

 Splash Screen: The SureTrend start-up splash screen can be disabled by 
unchecking this check box. 

 

9.3 Time and Date Format 

These options allow you to define the way in which times and dates are displayed. 

 

The format options are the same as those available on the luminometer. 

 AM/PM: Selects 12 Hour clock format (e.g. 9:41 PM) 

 24 Selects 24 Hour clock format (e.g. 21:41) 

 D/M/Y: Selects Date/Month/Year format (i.e.  DD/MM/YYYY) 

 M/D/Y: Selects Month/Date/Year format (i.e.  MM/DD/YYYY) 

 

TIP: The software can be set-up to automatically set the unit's internal clock to the 
current PC time, date, and format as defined above. Refer to section 9.5 for details. 
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9.4 Report Set-up and Printing Options 

The following general report set-up and printing options are available. 

 Standard Reports: The four quick-selection report toolbar buttons ( , ,  and ) 
can be configured to link to any of the Report set-up files, by selecting the report name 
from the appropriate drop-down list. 

 Report Page Header: By default, the words "SureTrend - Data Analysis Software" 
are printed at the top on each output page. This can be replaced with your Company 
Name, for example, or other text. 

 Shrink To Fit Page: When printing report data tables will lots of columns that would 
normally be too wide to fit on the printer paper, this option allows the output to be 
automatically reduced in size to fit the actual width of the paper. 

 

9.5 Luminometer Communications 

The following unit communications options are available. 

 Attempt to Self-Connect: Check this option to specific which PC serial port or USB 
port should be used to communicate with the luminometer and to automatically attempt 

to connect with the unit, without having to click the Connect button (see section 2.9). 

 Set Unit's Clock: Check this option to automatically set the luminometer’s internal 
real-time clock from the PC's clock and set the time and date format (see section 9.3) 
each time the software communicates with the luminometer. 
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9.6 SureTrend Data Files Options 

The following data file options are available. 

 Data File Location: By default, all of the SureTrend data files are stored with in the 

software installation folder, under the SureTrend sub-folder. This option can be used to 
specify an alternative location for these data files, such as a shared network drive. 
Refer to sections 1.1 and 2.7 for additional information and consideration. 

 Monitor Shared Files: Check this option to automatically monitor the status of 'open' 
shared data files and prompt the user when the file has been changed by another user. 

NOTE: This feature can be troublesome when used with some networked file servers 
and operating systems (such as Windows 98). 

 

10 Troubleshooting Tips 

This section lists typical problems that might be encountered when using this software, 
and their possible causes. 

For problems relating to the luminometer, please refer to the Troubleshooting section in 
the Luminometer Operator's Manual. 

Some problems and causes can be rectified by the operator, whilst others may require 
technical assistance. 

Severity Action Required 

 This indicates a cause which can be rectified by the user. 

 This indicates a cause which may require technical attention for 
rectification. Contact your local distributor for further assistance. 
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The following table lists typical symptoms and their possible causes. 

Symptom Possible Causes 

RS232 interface does 
not appear to be 
working 
 

 Wrong interface cable being used 
 Cable connector incorrectly inserted into unit 
 Cable connected to wrong serial port on PC 
 SureTrend software incorrectly installed or wrong options selected 
 Cable or connectors damaged or broken 
 PC serial port or system software faulty 
 Unit damaged or faulty  

Unable to read data 
from disk file 

 Wrong data file location specified (see section 9.6) 
 Data file is already open by another user 
 User does not have the appropriate permissions 
 Data file has been moved or the disk removed 
 Data file has been deleted or has been corrupted 
 Disk drive is damaged or faulty 

Unable to write data to 
disk file or create a 
new data file 

 Wrong data file location specified (see section 9.6) 
 Disk drive or user does not have write permissions  
 Data file is already open by another user 
 Existing file is write protected 
 Disk drive is full 
 Disk drive is damaged or faulty 

Unit has an invalid 
serial number 

 Luminometer memory fault 
(contact your local distributor for assistance) 

The Help file does not 
load 

 SureTrend software incorrectly installed (see section 1.1) 
 Adobe

®
 PDF Reader is not installed on your PC 

 Help file is damaged or missing 
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11 Technical Specifications 

General  

Minimum PC system requirements Pentium series PC 
1 RS232 port / adaptor or USB port 

Recommended Operating System Windows XP (SP2) 512MB RAM 

Results Database  

Maximum number of database records Unlimited * 

Reports  

Maximum number of Report set-up 

files 

Unlimited * 

Maximum number of Filter Conditions Unlimited * 

Maximum number of Report output 

files 

Unlimited * 

Unit Set-up Data  

Maximum number of Luminometers Unlimited* 

Other limitations Refer to section 0 

 

Although these items have no imposed limit, PC processor speed, memory size and hard disk 
capacity will ultimately limit the overall performance and usability of the SureTrend software 

 


